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INTRODUCTION

Welcome to a new level of multimedia - NuSound PnP 32!
The Orchid NuSound PnP 32 features the latest in
audio technology including: Plug and Play compatibility,
Spatializer 3D audio technology for two speaker sur-
round sound effects and superior wavetable synthesis.
NuSound PnP 32 provides complete compatibility with
software written for the leading sound standards like
Sound Blaster, Sound Blaster Pro, Windows Sound Sys-
tem, General MIDI, Roland MT-32 and General Synthe-
sizer.

Thank you for purchasing the NuSound PnP 32. Care has
been taken to ensure that it will provide you with years
of trouble-free operation and performance. We believe
you will be pleased with your purchase.

ABOUT THIS MANUAL

While the NuSound PnP 32 is designed to be easy to
install, we recommend that you refer to your computer’s
reference manual when terminology or installation steps
are unfamiliar to you.

Chapter 1: Hardware Installation
How to properly install the NuSound PnP 32 hardware
and information on connecting external devices.

Chapter 2: Driver Installation & Configuration
How to install the NuSound PnP 32 software and config-
uring the address settings.

Chapter 3: Utilities and Applications
Several sound-producing utilities and applications.

Chapter 4: Technical Information
Help to ensure that NuSound PnP 32 is operating prop-
erly.

Appendix A: Technical Specifications
NuSound PnP 32's technical specifications.

Appendix B: Glossary
Definitions for terms and programs used in this manual.
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BEFORE YOU BEGIN

This manual will familiarize you with the features, installa-
tion and use of the NuSound PnP 32. There are several
symbols and conventions used throughout this manual
which will help to draw your attention to a feature or to
focus on important information:

When you see the Magnifying Glass, it
refers to something you should take a
closer look at before proceeding further.

When you see the Exclamation Mark, it
gives important information on avoiding
damage to property.

Common Names

BBS Bulletin Board System

DAC Digital/Analog Converter

DMA Direct Memory Access

I/O Input/Output

IRQ Interrupt Request

MIDI Musical Instrument Digital Interface

MPC Multimedia PC

PC Refers to the family of IBM PC, PC/XT or
PC/AT compatible computers

PnP Plug and Play

SB Sound Blaster Emulation

WSS Windows Sound System Emulation

6
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1
Chapter INSTALLING NUSOUND PNP 32

Whether you are a beginner or experienced user,
NuSound's simplified design allows you to get up and
running quickly.

Hardware Installation

If you are connecting a CD-ROM drive, go to "Installing a CD-
ROM Drive," otherwise please continue.

1. If you previously installed another sound card, re-
move all associated files and drivers from your hard
drive. Consult the sound card's documentation for
information on removing drivers.

2. Turn off the power to your computer and remove
the computer cover.

3. Install the NuSound PnP 32 into a 16-bit ISA expan-
sion slot. Secure the mounting bracket to the com-
puter case.

4. Connect your external devices such as speakers and
microphone to the appropriate connector on the
NuSound PnP 32 bracket (refer to Figures 1.1 and
1.3).

5. Replace the cover of the computer and reconnect
previously removed cables.

You are now ready to install the NuSound PnP 32
software. Refer to Chapter 2: Software Installation.

Chapter 1: Hardware Installation
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STATIC!
Before
handling the
NuSound
PnP 32, be
properly
grounded by
touching the
power
supply
housing.
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Figure 1.1: NuSound PnP 32 Diagram

Chapter 1: Hardware Installation

8

J6 - Microphone type - Factory Setting

JP2 - IDE/ATAPI Interface Enabler - Closed/Disabled, Open/Enabled, Default/Closed

JP6 - Internal Motherboard/PC Speaker Connector

NOTE: Pin 1 on the connectors is indicated by a square
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Installing a CD-ROM Drive
NuSound PnP 32 has interface connectors for Panasonic
and IDE/ATAPI CD-ROM drives. The instructions here
will assist you in connecting your CD-ROM drive; how-
ever, you should also refer to the documentation pro-
vided by the CD-ROM drive manufacturer. Before you
begin, verify that your CD-ROM drive kit includes the
following:

❑ CD-ROM Drive with installation hardware
❑ 40-pin Interface Cable
❑ CD Audio Cable

1. If you are installing an IDE/ATAPI CD-ROM drive  to
the NuSound PnP 32, remove the jumper from JP2
to enable the secondary IDE/ATAPI CD-ROM in-
terface (refer to Figure 1.1).  NOTE: If you are using
the NuSound's secondary IDE interface, you must
disable any secondary IDE interface on your system
board or IDE controller.

2. Connect one end of the interface cable (ribbon-
type) to the CD-ROM drive interface connector. Be
sure to match the colored stripe to Pin 1 of the CD-
ROM drive interface connector.

3. Connect the other end of the cable to the Panasonic
or IDE connector on the NuSound PnP 32 card.
Make sure that Pin 1 on your cable (colored stripe)
is connected to this pin (refer to Figure 1.1).

4. Connect one end of the audio cable to the CD-ROM
drive's audio connector.

5. Connect the other end of the audio cable to either
the MPC-2 compatible CD-ROM audio connector
or the Sound Blaster CD Audio interface.

6. You are now ready to install NuSound PnP 32.
Return to the Hardware Installation section at the
beginning of this chapter.

Chapter 1: Hardware Installation
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Try to avoid
excessive
twists or
bends in the
cables  that
might
damage
them or
interfere with
other boards
in your
computer.

NuSound
PnP 32 uses
either an
MPC-2 or
Sound
Blaster
compatible
audio cable.
Contact your
CD-ROM
drive
manufac-
turer for
these
cables.
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Installing the Optional NuPanel

NuPanel is an optional feature available for NuSound PnP
32. It brings your audio connections and controls within
easy reach. The Rear Speaker or Line Out, Headphone,
Line In and  Microphone connections, as well as 3D On/
Off, Mute and Volume Control, can be conveniently
accessed from the front of your computer.

If your NuSound PnP 32 includes the NuPanel feature,
follow the installation steps below. To purchase the
NuPanel Interface Kit, call Orchid Customer Service.

Connecting NuPanel:

1. Select an available 3.5" drive bay. The NuPanel can be
installed either horizontally or vertically.

2. Attach the appropriate NuPanel label to NuPanel for
either the horizontal or vertical installation.

3. Secure the NuPanel in place with the enclosed
installation kit.

4. Configure jumpers JP1 and JP2 on the NuPanel
interface card for either 3D Speaker support or Line
Out operation. 3D Speaker
support is designed to fur-
ther enhance the Spatializer
3D audio technology of
NuSound PnP 32 with an ad-
ditional set of powered
speakers. (Refer to Table  1.1 for information on 3D
Speaker versus Line Out support).

5. Connect the color stripe side of the 34-pin interface
cable to Pin 1 of the NuPanel interface on NuSound
PnP 32 (refer to Figure 1.1).

6. Match the other end of the colored stripe side of the
cable to Pin 1 on the NuSound NuPanel connector.
NuPanel is installed!

Chapter 1: Hardware Installation
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You can also
install
NuPanel in a
5.25" drive
bay with a
standard
floppy drive
adapter kit.
Contact your
local
computer
dealer or
Orchid
Customer
Service.

Refer to your
computer's
reference
guide for
information on
installing
jumpers if
necessary.
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Chapter 1: Hardware Installation
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The  NuPanel Controls

Figure 1.3: NuPanel Diagram

NuPanel Controls Used For

3D Speaker

Line Out

Enhances 3D effect, requires amplified speakers

Recording source, amplified speakers, VCR

Headphones Stereo output for connecting headphones

Line In Tape player, record from home stereo

MIC Microphone input connection

3D Spatializer 3D ON/OFF

Mute Disables the audio output of the NuSound

Volume Adjusts the volume of the NuSound

Table 1.1: NuPanel Controls
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Chapter 1: Hardware Installation
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Connecting External Devices
NuSound Bracket

Connections
Used For

Speaker Headphones, non-amplified speakers

Line Out Recording source, amplified speakers, VCR

Line In Tape player, record from home stereo

MIC Microphone

DB-15 pin Joystick, MIDI instruments such as a keyboard (MIDI In/Out)
(Requires MIDI adapter cable)

NuSound On-Board
Connections

Used For

NuPanel Bring the audio control features to the front of your PC

CD Audio CD-Audio input (MPC2 and Sound Blaster compatible)

CD-ROM Play audio CD tracks, digital audio and MIDI music files

WaveBooster Wavetable synthesis card that increases polyphony up to 56 voices

Table 1.2: Connecting External Devices

←←←←←

←←←←←

→→→→→

←←←←←

→→→→→

Figure 1.4: NuSound PnP 32 Bracket
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2
Chapter SOFTWARE INSTALLATION

Once you complete the hardware installation and con-
nect your external devices, you can begin the software
installation. This chapter gives you information on install-
ing the NuSound PnP 32 software and changing the
configuration for Windows 3.1x, DOS and Windows 95
operating system environments.

NuSound PnP 32 also includes support for digital audio
functions in Windows NT 3.5x and OS/2 Warp. Software
drivers for Windows NT 3.5x and OS/2 Warp are
available through Orchid Customer Service or may be
downloaded from the Orchid Bulletin Board System or
CompuServe.

Windows 3.1x

Software Installation

1. Start Microsoft Windows.

2. Insert the NuSound PnP 32 Disk 1 into your floppy
drive.

3. From the Program Manager File menu, choose Run.

4. Type the floppy drive letter, then SETUP, e.g.,
A:\SETUP. The NuSound PnP 32 Welcome screen
appears. Click on Next to continue with the setup
program. The following screen appears:

Chapter 2: Software Installation
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This manual
presumes
that you are
familiar with
the basics of
Microsoft
Windows.
Please refer
to the
Microsoft
manual
when
terminology
or installa-
tion steps
are
unfamiliar to
you.

Figure 2.1: NuSound PnP 32 Setup Screen
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5. Select the software installation location. Click on
Next to install the NuSound PnP 32 audio software.

6. Proceed through the installation as prompted by the
program. Once the software installation is complete,
the NuSound PnP 32 configuration screen appears:

7. You can change the NuSound PnP 32 settings or
accept the default settings. The SETUP program will
automatically update your system files.

8. Click on OK to continue. You are then prompted to
restart your computer to initialize NuSound PnP 32.
After Windows is restarted, the NuSound program
group appears on the Windows desktop.

DOS Configuration

The NuSound PnP 32 DOS configuration program allows
you to change your NuSound PnP 32 configuration from
the DOS prompt. You can run the DOS configuration
program from the DOS prompt by typing:

CD\NUSOUND

then

NUSDCFG

14

If you need
to change
the
configuration
at a later
time, click on
the NuSound
PnP 32
Audio Setup
icon in the
NuSound
program
group.

Figure 2.2: NuSound PnP 32 Audio Setup

If you
encounter a
conflict that
prevents
you from
entering
Windows,
you can
make
changes to
your
configura-
tion from
DOS.

Chapter 2: Software Installation
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Make your selections from the menu bar. Select OK to
save your settings. You will need to restart your com-
puter for the new settings to take effect.

Configuration Program Descriptions

The following information describes the options available
for the Windows and DOS configuration programs.

Digital Audio Codec

I/O Address: Used for digital audio operation in Win-
dows.  Setting is required for Windows Sound System.
Interrupt: Used for digital audio operation in Windows
and shared with Sound Blaster operation in DOS.  Setting
is required for Windows Sound System and Sound
Blaster.

Play DMA: Used for digital audio operation in Windows
and shared with Sound Blaster operation in DOS.  Setting
is required for Windows Sound System and Sound
Blaster.

Capture DMA: Used for full duplex operation in Win-
dows.  Setting is required for full duplex mode with
Windows Sound System.  If full duplex operation is not
required, the selection should be configured for the same
setting as Play DMA.

Single Mode DMA:  Used for digital audio playback in
Windows.  Enabling the setting is recommended for
Windows Sound System.

Blaster

I/O Address: Used for Sound Blaster in DOS.  Setting is
required for Sound Blaster.

Control

Chapter 2: Software Installation
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I/O Address: Used to access the internal register settings
of NuSound PnP 32. Setting is required for NuSound PnP
32 operation.
GamePort Joystick

I/O Address: Used for GamePort Joystick operation in
Windows 95 and DOS. Setting is required for GamePort
Joystick use.

NuSound PnP 32 FM

I/O Address: Used for FM synthesis operation in Win-
dows.  Setting is required for FM synthesis playback.

MPU-401

I/O Address: Used for wavetable synthesis operation in
Windows and DOS.  Setting is required for wavetable
synthesis playback.

Interrupt: Used for MIDI recording operation in Win-
dows and DOS.  Setting is only required for MIDI
recording.

IDE ATAPI CD-ROM

I/O Address:  Used for CD-ROM operation in Windows
and DOS.  Setting is required for CD-ROM use.

Panasonic CD-ROM

16

Chapter 2: Software Installation
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I/O Address:  Used for CD-ROM operation in Windows
and DOS.  Setting is required for CD-ROM use.

About CD-ROM Drives

IDE/ATAPI

The NuSound PnP 32 secondary IDE interface requires
I/O address 170 and IRQ 15. No DMA setting is required.
NOTE: Different operating systems include drivers for
IDE/ATAPI CD-ROM drives. Ensure that you are using
the latest driver for your CD-ROM drive. Contact the
CD-ROM drive manufacturer should you encounter any
problems with the drivers.

Panasonic

The NuSound PnP 32 Panasonic interface requires only
an I/O address. No IRQ or DMA setting is required. To
configure the I/O address, run the configuration pro-
gram.

About CD-ROM Device Drivers
If you have installed a CD-ROM drive with NuSound PnP
32, verify that the following device driver line:

"Device=C:\NuSound PnP 32\CS4232C.EXE /O /V"

is loaded in the CONFIG.SYS file before any other CD-
ROM device drivers. NOTE: When configuring device
drivers for CD-ROM drives, verify that the address
settings match the NuSound's address settings (run the
configuration program).

Chapter 2: Software Installation
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Windows 95

Driver Installation

Because NuSound PnP 32 is Plug and Play compatible,
Windows 95 will automatically detect and configure the
NuSound's address settings. Follow the steps below to
install the NuSound PnP 32 software.

1. Start Microsoft Windows 95, the following screen
appears:

2. Insert the NuSound PnP 32 Disk 1 into your floppy
drive.

3. From the New Hardware Found screen, select the
Driver From Disk Provided By Hardware Manufac-
turer option. Click on OK.

4. Windows 95 will automatically detect and install
drivers for the NuSound audio, MPU-401 interface
and GamePort. NOTE: If you choose not to install a
NuSound PnP 32 feature, select the Do Not Install
option.

5. Windows 95 copies the NuSound PnP 32 drivers to
your hard drive and updates your system files. You
are then prompted to Restart or Shut Down your
computer for the changes to take effect.

18
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If you
happen to
install a
compatible
audio driver,
you should
remove it
through the
Device
Manager.

Figure 2.3: New Hardware Found Screen
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6. Select the Shut Down option. After it is safe to shut
down your computer, turn the power off and back
on to restart Windows 95.

Changing the Configuration

1. From the My Computer group, double-click on the
Control Panel icon.

2. Double-click on the System icon and the following
screen appears:

3. From the tabs at the top of the screen, select Device
Manager. The following screen appears:

19

Chapter 2: Software Installation

Figure 2.4: System Properties Menu

Please note
that some
Plug  and
Play
configura-
tions may
not allow you
to change
resources.

Figure 2.5: Device Manager Screen
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4. Double-click on the Sound Video and Game Con-
trollers option.

5. Click on your selection and then click on properties.

6. Click on Resources to change the configuration.

7. From the Resources Settings box, select the Re-
source Type you want to configure.

8. Click on the Use Automatic Settings box to uncheck
the option.

9. Click on the Change Settings box to configure the
new setting.  NOTE: You may be able to use a
different configuration by clicking a different option
in the Settings Based On box.

10. Repeat steps 5 through 9 for each selection. Once all
your selections are made, click on OK to restart
your computer for the changes to take effect.

Switching between FM and Wavetable Synthesis

1. From the My Computer group, double-click on the
Control Panel icon.

2. Double-click on the Multimedia icon. The following
screen appears:

20
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If you choose
a setting that
is already in
use by other
hardware,
the conflict
may be listed
in the Conflict
Information
box.

Figure 2.6: Multimedia Properties Screen
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3. From the tabs at the top of the screen, select MIDI.

4. Make your selection and click on OK.

Installing NuSound PnP 32 Applications for Windows 95

1. From the Windows 95 desktop, click on Start then
click on Run.

2. Insert the NuSound PnP 32 Disk 1 into your floppy
drive.

3. Type the floppy drive letter, then SETUP, e.g.,
A:\SETUP.

4. The installation program automatically copies the
NuSound PnP 32 audio software to your computer.

Chapter 2: Software Installation
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Chapter 2: Software Installation
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Chapter

3
This manual
presumes
that you are
already
familiar with
the basics of
Microsoft
Windows.
Please refer
to the
Microsoft
manual when
terminology
or installation
steps are
unfamiliar to
you.

UTILITIES AND APPLICATIONS OVERVIEW

NuSound PnP 32 comes with great sound-producing
software for DOS, Windows 3.1x and Windows 95.
These utilities and applications will enhance the perfor-
mance of your NuSound PnP 32 and your CD-ROM
drive.

UTILITIES

DOS Control Panel
The NuSound PnP 32 DOS Control Panel allows you to
easily fine tune your instrument settings for DOS games
and sequencing applications. You can run the NuSound
PnP 32 Control Panel from the DOS prompt by typing:

CD\NUSOUND

then

NUCTLDOS.EXE

The following screen appears:

The changes you make while the control panel is open
will not take effect until you click on the OK button.

Selections

Synthesizer

The Synthesizer instrument selection can emulate differ-
ent music synthesizers. Before running any game, make
sure that the proper emulation mode is selected.

Chapter 3: Utilities and Applications
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Figure 3.1 : NuSound PnP 32 DOS Control Panel
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Drum Set

The Drum Set instrument selection allows you to  choose
from one of eight different drum sets.

MIDI Channel Enable

The channel where MIDI messages are received.

3D Sound ON/OFF

Enables or disables the 3D sound Spatializer chip.

DOS Mixer

The DOS Mixer allows you to control the output levels
of all sound devices supported by NuSound PnP 32. You
can run the Mixer utility from the DOS prompt by typing:

CD\NUSOUND

then

NUSDMIX.EXE

The following screen appears:

Selections

Volume Controls

To adjust the volume for the Master, Wave, Line, MIC,
FM and CD options, move the scroll bar to the desired
level.

Chapter 3: Utilities and Applications
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Figure 3.2 : NuSound PnP 32 DOS Mixer Screen



NuSound PnP 32 User's Manual

Input Select

Use this selection to select a port to use for recording.
Your port options are: Line, MIC and CD.

Gang

This selection is used for modifying the left and right
volume of each volume control simultaneously. After
modifying the volume value for each channel, use the OK
button to save the new values.

DOS CD Player

The DOS CD Player lets you play music from your own
audio CD's using the same familiar interface you find on
your home stereo CD player. You can run the CD Player
from the DOS prompt by typing:

CD\NUSOUND

then

ORCHIDCD.EXE

The following screen appears:

While your CD is playing, the CD Player utility displays
the CD length, time elapsed, track number and time in the
track.

Chapter 3: Utilities and Applications
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Figure 3.3:  NuSound PnP 32 CD Player Screen



NuSound PnP 32 User's Manual

DOS Diagnostic

The diagnostic utility tests the address settings configured
for your NuSound PnP 32 card. You can run the Diagnos-
tic utility from the DOS prompt by typing:

CD\NUSOUND

then

ORCHDIAG.EXE

The following screen appears:

You can move between fields using the TAB key, arrow
keys or your mouse. Select the Test button for the device
you want to test.

NOTE: The joystick test will require a joystick to be
attached to perform the test. If the test is attempted with
no joystick device attached, the ESC key can be used to
abort the test. The joystick test field will be highlighted to
indicate the test failure.

The diagnostics will run a series of tests to verify the
correct operation of the selected device. On completion
of the test, the field between I/O and <Test> will change
to reflect Pass or Fail. In case of a failure, the failing device
will be highlighted.

Chapter 3: Utilities and Applications
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The DMA,
IRQ and I/O
settings are
displayed, but
are not
selectable.
To change
the address
settings, run
the configura-
tion program.Figure 3.4 : NuSound PnP 32 Diagnostic Screen
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Chapter 3: Utilities and Applications
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Windows MIDI Control Panel

The MIDI Control Panel allows you to easily configure
your MIDI input and output device(s) and fine tune your
instrument settings.

1. From the NuSound group, double-click on the MIDI
Control Panel icon and the following screen appears:

2. Use your mouse  to click on the menu selections or
hold down the ALT key and press the underlined
letter.

3. Click on the control panel feature of your choice and
move the slider to adjust the performance selection
you want.

Figure 3.5 : MIDI Control Panel Screen

To access
on-line help,
click on
Contents
from the
Help menu.
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Chapter 3: Utilities and Applications

WINDOWS APPLICATIONS

Media Rack Audio Control System

Media Rack lets you control and play audio using your PC
and NuSound PnP 32.  Even without audio experience or
special equipment, you can do all of the following:

• Play MIDI music files

• Play digital audio (wave) files

• Play audio CD tracks

• Make custom collections of your favorite music and
sounds

• Have your PC tell you the current date and time in a
human voice, and play audio reminders

• Control the volume levels of your NuSound's inputs
and outputs

To run Media Rack:

1. From the NuSound group, double-click on the Media
Rack icon. The following screen appears:

28

Figure 3.6:  Media Rack Screen
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Chapter 3: Utilities and Applications

To access
on-line help,
click on
Contents
from the
Help menu.

2. Click on the component buttons on the Button Bar to
alternately hide or display a player component.

3. Click on the sideways-pointing arrow on the Button
Bar to show Media Rack in full or condensed view.

4. Click on any component to make its component-
specific menu available on the Menu Bar.

5. Use your mouse, keyboard, or keystroke macros to
control the component from the component’s menu.

Media Rack Features

From the Select Menu you can select the following
features:

• Control Center - Provides overall control of Media
Rack’s components. Allows you to display or hide the
components and control them through menus.

• Alarm Clock - Speaks aloud the current time and date
at intervals you  specify, and plays selected wave files
as reminders or alarms at times you set.

• MIDI Player - Plays MIDI music.  It allows you to create
playlist collections of music, and play them once or
repeatedly, in sequential or random order. You can
also launch external MIDI sequencer programs to
modify MIDI music files.

• Wave Player - Records, plays and edits digital audio
(wave) files. It allows you to create playlist collections
of audio files and play them once or repeatedly, in
sequential or random order.

• CD Player - Plays your favorite audio CD's. It allows
you to create playlist collections of CD tracks (songs),
and play them once or repeatedly, in sequential or
random order.

• System Mixer - Controls the volume levels of all PC
audio inputs and outputs.

29
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Wave Shaper

Wave Shaper allows you to record, play and edit digital
audio (wave) files. Wave Shaper also lets you "audio
annotate" documents. That is, you can record audio
using Wave Shaper and insert it as a comment into
documents you create using most Windows applica-
tions.

1. From the NuSound group, double-click on the Wave
Shaper icon.  The following screen appears:

2. Open an existing wave file or record new audio.

3. To play the file, click on the Play button. To stop
playing, click on the Stop button. The Position Slider
moves to  the right during file playing and indicates the
current file position.

4. To record the open wave file, click in the Zoom View
window to select the point at which you wish to
record. From the Options menu click on Paste Mode
to select how you wish to insert your audio.

5. Click on the Record button. Speak into the micro-
phone (or press the Play button on your recording
device).

6. When finished, click on the Stop button.
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Figure 3.7 : Wave Shaper Screen

To access
on-line help,
click on
Contents
from the
Help menu.
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Recording Session

Recording Session is a powerful sequencer offering many
standard MIDI sequencing features, as well as an editable
musical notation display. There are three windows, or
views that you use to play and edit your musical compo-
sitions: Score View, Mixer View and MIDI List View.

Opening a Song:

1. From the NuSound group, double-click on the Re-
cording Session icon. The following screen appears:

2. From the File menu, click on Open. Click on the File
Types list box and choose a file format.

3. Select the song file you want to open. Click on OK to
load the song into memory.

Recording a Song

1. To record a song file, first clear the memory by
choosing the New command from the File menu. This
clears the memory and sets you up with the equivalent
of a blank canvas.

2. From the View menu, select the Mixer View.

3. Click on the Record button in the Mixer View, and the
metronome will start to tick. You are ready to record.

Figure 3.8:  Recording Session Window

Verify that
your MIDI
instrument is
properly
connected
before
recording.

To access
on-line help,
click on
Contents
from the
Help menu.
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Key-Z Player

Key-Z Player brings an innovative approach to playing
music. With Key-Z Player you can play instrumental
music from your computer, using a standard computer
keyboard. The unique note mapping feature prevents you
from playing an incorrect note in your chosen Key or
Scale. Your computer is transformed into an intelligent
polyphony (multiple notes at a time) musical instrument
that is exhilarating to play.

Key-Z Player incorporates the following features: a
standard MIDI file song player, graphic piano keyboard
display, graphic mixer with volume, channel, patch, pan
and mute control, and over 40 song styles.

To run Key-Z Player:

1. From the NuSound group, double-click on the Key-Z
Player icon. The following screen appears:

The buttons at the top of the screen are from left to right:
File, Key, Scale, Layout, Settings, Player, Piano, Mixer, and
Help. To access a feature, click once on the feature.

Key-Z Player - Solo

Key-Z Player can be used to perform solo compositions,
test melodies, play rhythm and bass tracks, and learn
scales and arpeggios in various keys.
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Figure 3.9: Key-Z Player Screen

To access
on-line help,
click on
Contents
from the
Help menu.
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1. Select the Key and Scale you desire.

2. Select the Patch for the sound you desire.

3. Select the keyboard mapping from the Layout menu.

4. Set your Volume and begin playing by tapping out
notes on your computer keyboard.

Key-Z Player - Accompanied

Key-Z Player can perform melodies while being accom-
panied by any standard MIDI Song File played in real-time.

1. Open the Song Player window by clicking on the
Player menu button.

2. Click on the Open Song button and select a song to
play.

3. When the file is opened, it will use the default settings
for Key, Scale and Tempo. In addition, the track
structure of the Song File (including the instrument
name and MIDI channel) is set into the Mixer.

NOTE:  Key-Z Player can read and play Format 0 and
Format 1 MIDI files. The standard MIDI files included
with Key-Z Player are Format 1 files and contain the
optional Key and Scale data.

Note Progression

Notes begin with the lowest left row (the Z row) in
Horizontal Mapping, and the "A" key in Jagged Mapping.
This ends with the highest note on the upper right.

Sustain

There are several ways to get sustained notes: (1) For
continuous sustain, press the Caps Lock key. The notes
played are sustained until the Caps Lock key is pressed
again. (2) Hold down the Shift key while playing various
notes.

To access
on-line help,
click on
Contents
from the
Help menu.

See on-line
help for the
MIDI Drum
Patch
Settings.
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TECHNICAL INFORMATION OVERVIEW

Orchid Technology is known for its responsiveness to its
customers. So we have created a list of helpful hints for
troubleshooting your NuSound PnP 32.

CompuServe

In addition to calling Orchid technology, technical sup-
port is now available through the CompuServe Informa-
tion Service (CIS). You can also download drivers and get
new product information. To find us on CompuServe,
follow the instructions below:

1. Log onto CompuServe.

2. You may type GO ORCHID to get immediate access
to the Orchid section . . .

or

Type GO MULTIBVEN to get into the Multimedia
Vendor Forum B. Once you are in this forum, select
Message Section #10. The message and library sec-
tions are labeled Orchid.

Before You Begin

Because of the unique hardware design of the NuSound
PnP 32, each sound standard is independent of the other.
This is how NuSound PnP 32 can emulate multiple sound
standards simultaneously. When troubleshooting the
NuSound PnP 32 for potential conflicts, it is important to
remember that if a sound standard works correctly, the
problem generally becomes a software issue.

Chapter

4

All commands
can be typed
in lower or
upper case
letters.

Chapter 4: Technical Information
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Troubleshooting

The following information will help you diagnose prob-
lems you may have with the NuSound PnP 32. The
symptom and solution serves a twofold purpose:

You may be able to fix your problem. . .

 or

if these tips do not help solve your problem,
they will most certainly give you a better handle
on what to tell Technical Support once you
contact them.

Chapter 4: Technical Information
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Symptom Solution
Computer locks up on bootup with the
NuSound

(1) Possible IRQ, DMA or I/O address
conflict. Verify that the address settings of
other peripherals in your computer are not
in conflict with those configured for
NuSound.
(2) Possible secondary IDE interface conflict.
If not in use, verify that the NuSound IDE
interface is disabled by closing jumper JP2.
(3) If your system BIOS supports Plug and
Play, but your operating system (MSDOS) is
not Plug and Play, verify that the Plug and
Play option in the system BIOS is disabled.

My joystick does not work when
connected to the NuSound

(1) Verify that the Gameport Joystick on the
NuSound is enabled. Run the NUSDCFG
program from DOS or double-click on the
NuSound Audio Setup icon in Windows.
(2) Possible address conflict. Select another
address for the NuSound Gameport Joystick.

NuSound is not recognized or initialized
properly in DOS

(1) Verify that the device driver line:
C:\NUSOUND\CS4232C.EXE /O /V is
loaded in the CONFIG.SYS file.
(2) If your system BIOS supports Plug and
Play and your operating system (Windows
95) is Plug and Play, verify that the Plug and
Play option in the system BIOS is enabled.

No display in Windows with NuSound
installed

(1) If you are using a non-Plug and Play
operating system, go to the [sndsys.drv]
section of your SYSTEM.INI file and verify
that the following line is present: UsePnP=0.

Installation
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CD-ROM

Symptom Solution
I cannot access an IDE/ATAPI CD-ROM
drive

(1) Verify that the NuSound device driver
line is loaded in the CONFIG.SYS file
before any other CD-ROM device drivers.
Verify that the MSCDEX or similar device
driver is loaded in the AUTOEXEC.BAT
file.
(2) Verify that the NuSound IDE Interface is
enabled by opening jumper JP2.
(3) If there is a LASTDRIVE statement in
the CONFIG.SYS file, verify that the drive
letter used is set to a letter after the
CD-ROM drive.
(4) Check the CD-ROM cable connection.
Verify that the color strip is connected to
pin 1 on both the NuSound and CD-ROM
drive.
(5) Verify no other devices are using I/O
address 170 and IRQ 15.

I cannot access a Panasonic CD-ROM
drive

(1) Verify that the NuSound device line is
loaded in the CONFIG.SYS file before any
other CD-ROM device drivers. Verify that
the MSCDEX or similar device driver is
loaded in the AUTOEXEC.BAT file.
(2) Verify that the NuSound and CD-ROM
drive are configured for the same address
settings.
(3) If there is a LASTDRIVE statement in
the CONFIG.SYS file, verify that the drive
letter used is set to a letter after the
CD-ROM drive.
(4) Check the CD-ROM cable connection.
Verify that the color strip is connected to
pin 1 on both the NuSound and CD-ROM
drive.

My CD-ROM does not play CD audio (1) Verify that the CD audio cable used
matches the pin-outs for the CD Audio
connector. See Appendix A for the MPC-2
and Sound Blaster CD Audio interface pin
assignments.
(2) The CD Volume in the system mixer
may be muted or turned down. Verify
mixer settings.
(3)Verify that the speakers are connected
properly to the speaker jack.



NuSound PnP 32 User's Manual

Chapter 4: Technical Information

38

Digital Audio

Symptom Solution

No digital audio playback (Sound Blaster
Emulation) in DOS games

(1) Insufficient resources to run the
application properly. See your game's
instruction manual for memory
requirements and tips on how to configure
your computer.
(2) Verify that the application is configured
for either Sound Blaster or Sound Blaster
Pro emulation for digitized sound.
(3) Verify that the application is configured
for the same Sound Blaster address settings
used by NuSound.
(4) The volume may be muted or turned
down. Check the DOS mixer settings
and/or the application’s volume settings.
(5) Verify that the speakers are connected
properly to the speaker jack.

Digital WAV files do not playback (WSS
Emulation) in Windows 3.1x or
Windows 95

(1) Verify that the NuSound WSS Audio
Driver is installed and the WSS interface is
operating properly. (In Windows 3.1x, click
on the NuSound Setup icon in the
NuSound Program Group. In Windows 95
click on the System icon in Control Panel
and select Device Manager).
(2) Possible address conflict. Verify that the
settings for the NuSound WSS Audio
Driver are not in conflict with another
hardware device.
(3) The WAV Volume in the system mixer
may be muted or turned down. Verify
mixer settings.
(4) If another sound card was previously
installed, verify all associated drivers have
been removed from the system files
(CONFIG.SYS, AUTOEXEC.BAT,
SYSTEM.INI).
(5) Verify that the speakers are connected
properly to the speaker jack.
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Digital Audio (cont.)

Symptom Solution

Digital WAV file keeps repeating (1) IRQ conflict. Change NuSound WSS
IRQ setting.

Computer locks up when attempting to
play Digital WAV files

(1) DMA conflict. Change NuSound WSS
DMA setting.

When using the microphone, audio does
not record properly or quality is poor

(1) The microphone is a mono input
source. Verify that recording settings are
configured for mono.
(2) Verify that the microphone is connected
properly to the microphone input jack.
(3) Make sure that the microphone is
selected as the recording source.
(4) Verify that microphone input level is set
to an appropriate setting.
(5) Verify that the format used for
recording is configured for the desired
sound quality.



NuSound PnP 32 User's Manual

Chapter 4: Technical Information

40

MIDI

Symptom Solution

No MIDI music playback (General MIDI
emulation) in DOS games

(1) Insufficient resources to run the
application properly. See your game's
instruction manual for memory
requirements and tips on how to configure
your computer.
(2) Verify that the application is configured
for General MIDI emulation for music.
(3) Verify that the application is configured
for the same General MIDI address settings
used by NuSound.
(4) The volume may be muted or turned
down. Check the DOS mixer settings
and/or the application’s volume settings.
(5) Verify that the speakers are connected
properly to the speaker jack.

The MIDI music playback quality sounds
poor in DOS games

(1) Verify that the application is configured
for General MIDI for music playback. This
produces superior wavetable synthesis
playback versus FM synthesis.

MIDI files do not playback (General
MIDI Emulation) in Windows 3.1x or
Windows 95

(1) Verify that the NuSound MPU-401
Audio Driver is installed and the MPU-401
interface is operating properly. (In
Windows 3.1x, click on the NuSound Setup
icon in the NuSound Program Group. In
Windows 95 click on the System icon in
Control Panel and select Device Manager).
(2) Possible address conflict. Verify that the
settings for the NuSound MPU-401 are not
in conflict with another hardware device.
(3) The SYNTH volume in the system
mixer may be muted or turned down.
Verify mixer settings.
(4) If another sound card was previously
installed, verify all associate drivers have
been removed from system files
(CONFIG.SYS, AUTOEXEC.BAT,
SYSTEM.INI).
(5) Verify that the speakers are connected
properly to the speaker jack.
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MIDI (cont.)
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Symptom Solution

MIDI playback quality is poor in
Windows 3.1x or Windows 95

(1) Verify that the MIDI Mapper is
configured for General MIDI, MPU-401 or
Wavetable, not OPL3 FM. (In Windows
3.1x, click on the MIDI Mapper icon in the
Control Panel. In Windows 95, select MIDI
from the Multimedia icon in the Control
Panel).

Some MIDI sequences produce strange
sounds with the MIDI Mapper configured
to send all 16 MIDI channels

(1) If the sequences in question were
written to conform to the MPC MIDI
authoring standard, then these sequences
will contain two separate versions of the
composition. If all 16 MIDI channels are
sent to NuSound when playing these
sequences, both arrangements are heard
simultaneously.
(2) Try configuring the MIDI Mapper to
send only MIDI channels 1-10 to NuSound's
MPU-401 driver. Select None for channels
11-16. (In Windows 3.1x, click on the MIDI
Mapper icon in the Control Panel. In
Windows 95, select MIDI from the
Multimedia icon in the Control Panel).

External keyboard or synthesizer does
not perform properly when connected
to NuSound

(1) Verify that the MPU-401 Input IRQ is
enabled and configured.
(2) Verify that MPU-401 is selected as the
input device.
(3) Possible IRQ conflict. Verify that the
IRQ settings for the NuSound MPU-401
Input is not in conflict with another
hardware device.
(4) Verify that the MIDI connections are
installed properly. NuSound MIDI IN to
Keyboard MIDI OUT - NuSound MIDI
OUT to Keyboard MIDI IN.
(5) You may have a defective MIDI
connector device.
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Avoiding Address Conflicts

A conflict may occur if you have another card in your
computer using the same I/O, DMA or IRQ addresses as
NuSound PnP 32. Resolve the conflict by selecting an-
other available address. When selecting a different ad-
dress, please note the following information:

☞ A BUS mouse commonly uses I/O address 240H

☞ Network cards commonly use the following ad-
dresses:

IRQ 10 or 11

I/O 300H, 320H, 340H or 360H

☞ Other devices such as SCSI cards, hard disks and
CD-ROM drives commonly use the following ad-
dresses:

IRQ 10, 11, 14 or 15

I/O 330H or 340H

☞ When you encounter an IRQ conflict, you will
normally hear a continuous noise from the speakers.
I/O and DMA conflicts normally lock up your com-
puter.

☞ For Full Duplex mode, NuSound PnP 32 must have
a separate DMA Channel specified for the Capture
DMA. If Full Duplex is not desired, set the Capture
DMA to the same setting  as the Play DMA.

Chapter 4: Technical Information
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TECHNICAL SPECIFICATIONS

This appendix provides the technical specifications and
features of NuSound PnP 32.

NuSound PnP 32 Configuration
NuSound PnP 32 (16-bit ISA Slot)

Multimedia Compatibility
Full compatibility with the following sound and multi-
media standards:
• Sound Blaster/Sound Blaster Pro
• AdLib
• Microsoft Windows Sound System
• General MIDI (for Wavetable Synthesis)
• General Synthesizer and MT 32
• Roland MPU-401 MIDI Interface
• MPC Level I and Level II

Chipsets

Crystal Semiconductor 4232 Codec
Crystal Semiconductor 9233 Wavetable Synthesizer
Crystal Semiconductor 4331 18-Bit DAC

Computers Supported:

ISA machines: 386, 486 and compatibles

Temperature:
Operating:  from 0 to 40 degrees C
Storage:  from -25 to 90 degrees C

Humidity:
Operating:  from 15% to 90%
Storage:  from 0% to 90

Appendix

A
Appendix A: Technical Specifications
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Audio Connections:

3.5 mm Amplified Speaker Output
3.5 mm Line Level Stereo Output
3.5 mm Line Level Stereo Input
3.5 mm Dynamic or Condensed MIC - Mono
Internal CD-Audio Inputs (MPC 2 and

Sound Blaster Compatible)

Other Interfaces:
Panasonic CD-ROM Interface
IDE ATAPI CD-ROM Interface
DB-15 Joystick/MIDI Port
MIDI IN/OUT Ports (MIDI interface kit sold separately)

WaveBooster/WaveBlaster Compatible Synthe-
sizer Header (for WaveBooster Daughtercard)

Optional NuPanel Interface

NuSound PnP 32 Synthesizer Specifications
Sound Blaster Mode

20-Voice FM Synthesis

General MIDI, MT-32, General Synthesizer
1MB Wavetable ROM (compressed)
Up to 32 Simultaneous Voices
190 Instrument Sounds
107 Percussion Sounds
46 Special Effects

NuSound PnP 32 Audio Specifications
8-bit and 16-bit Sample Modes
Sampling Rate of: 2KHz to 48KHz
Audio Compression Formats: µ-law (2:1),

PCM (1:1), ADPCM (4:1) and Big Endian
S/N Ratio: >85 DB
Frequency Response: 20Hz to 22KHz

Appendix A: Technical Specifications
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NuSound PnP 32 Pin Assignments

The following information provides you with the pin
assignments for the NuSound PnP 32 audio interfaces,
PC speaker, NuPanel interface and joystick/MIDI port.

Appendix A: Technical Specifications

45

Sound Blaster CD Audio Interface

Pin Assignment

1 Ground
2 CD Audio Left
3 Ground
4 CD Audio Right

Table A.1 : CD Audio  Pin-Outs

MPC-2 CD Audio Interface

Pin Assignment

1 CD Audio Left
2 Ground
3 Ground
4 CD Audio Right

Table A.2 : CD Audio  Pin-Outs

PC Speaker Interface

Pin Assignment

1 No Connection
2 PC Speaker

Table A.3 : PC Speaker  Pin-Outs

NOTE:  PC Speaker is the motherboard's internal PC
Speaker connection. It allows PC Speaker sound to play
through NuSound PnP 32.
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Joystick/MIDI Port

The joystick port on NuSound PnP 32 is identical to the
standard PC Game Control adapter. The 15-pin D-sub
connector is also used as the built-in MIDI interface.  The
pin-out assignments are as follows:

Pin Function Pin Function

1 +5V 9 +5V

2 A-1 10 B-1

3 A-X 11 B-X

4 GND 12 MIDI-OUT

5 GND 13 B-Y

6 A-Y 14 B-2

7 A-2 15 MIDI-IN

8 +5V

Figure A.1:  Joystick/MIDI Connector

Table A.4:  Joystick/MIDI Pin-Outs

Appendix A: Technical Specifications
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NuPanel Interface

Pin Function

2 Ground

4 Ground

6 Ground

8 Ground

10 Ground

12 Ground

14 Ground

16 Ground

18 Ground

20 Ground

22 Ground

24 Ground

26 Ground

28 Ground

30 +12 Volt

32 Ground

34 Ground

Pin Function

1 Line In Left

3 Line In Right

5 Microphone In

7 Volume Left

9 Line Out Left

11 Line Out Right

13 Speaker Out Left

15 Speaker Out Right

17 Volume Right

19 Synthesizer Out Left

21 Synthesizer Out Right

23 Not Used

25 Not Used

27 3D Rear Speaker

29 3D Depth

31 3D On/Off

33 Not Used

NuPanel MIDI Interface

Pin Assignment

1 MIDI Transmit
2 MIDI Receive
3 +.5V
4 Ground

Appendix A: Technical Specifications
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Table A.5: NuPanel Pin-Outs

Table A.6 : NuPanel MIDI Pin-Outs
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Appendix

B
GLOSSARY

CD Player A DOS utility that lets you play music
from your own audio CD's using the same familiar
interface you find on your home stereo CD player.

CODEC Compression/Decompression Algorithm.
A software compression and decompression method.

Control Panel The Windows MIDI Control Panel
allows you to easily configure your MIDI input and
output device(s) and fine tune your instrument settings
from Windows.

CS4232 The NuSound PnP 32's on-board CODEC
chip.

DOS CD Player The CD Player lets you play
music from your own audio CD's using the same
familiar interface you find on your home stereo CD
player.

DOS Diagnostic The diagnostic utility tests the
address settings configured for your NuSound PnP 32
card.

DOS Mixer The Mixer allows you to control the
output levels of all sound devices supported by NuSound
PnP 32 from DOS.

Full Duplex A method to play and record digital
audio simultaneously.

General MIDI A multimedia sound standard that
provides for compatibility between MIDI software and
MIDI equipment. General MIDI defines 128 musical
instrument sounds and 47 percussion sounds.

Appendix B: Glossary
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General Synthesizer A multimedia sound stan-
dard that expands on the General MIDI standard by
providing additional banks of instrument sounds.

Half Duplex A way to play and record digital audio
but not simultaneously.

Key-Z Player A Windows application that allows
you to play instrumental music from your computer,
using a standard computer keyboard.

Media Rack Media Rack is a Windows application
that lets you control and play audio using your PC and
NuSound PnP 32.

MIDI Musical Instrument Digital Interface. A stan-
dard format for computer generated music.  MIDI
music on PCs running Windows is stored in files with
the .MID file extension.

MIDI Control Panel The MIDI Control Panel al-
lows you to easily configure your MIDI input and output
device(s) and fine tune your instrument settings from
Windows.

MIDI Interface A hardware device that allows your
computer to communicate with other MIDI devices
such as an electronic keyboard. NuSound PnP 32 has a
DB-15 connector used for MIDI instrument connec-
tions.

Mixer The Mixer utility allows you to control the
output levels of all sound devices supported by NuSound
PnP 32 from DOS.

Appendix B: Glossary
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MPU-401 Industry standard hardware MIDI inter-
face first developed by Roland. This made possible the
productive relationship between computers, electronic
musical instruments and musicians.

MT-32 One of the first wavetable synthesizer add-
on modules. It features different mappings as compared
to General MIDI. Many older games support MT-32.

NuPanel NuPanel brings audio connections and
controls to the front of your PC. The NuPanel interface
provides Rear Speaker or Line Out, Headphone, Line In
and Microphone connections, as well as 3D On/Off,
Mute and Volume Control.

Plug and Play A specification for hardware and
software that allows automatic configuration of Plug
and Play devices in your computer. The idea is to
provide minimal user intervention in the computer
configuration.

Recording Session A Windows sequencer appli-
cation offering many standard MIDI sequencing fea-
tures, as well as an editable musical notation display.

Spatializer 3D Audio technology that produces
two-speaker sound effects.

Wave Shaper A Windows application that allows
you to record, edit and play WAV files.

Wavetable Synthesis A method of synthesizing
sound based on playing back short samples of actual
instruments. Because it uses recordings of actual instru-
ments, wavetable synthesis sounds more realistic than
FM synthesis.

Appendix B: Glossary
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LIMITATION OF LIABILITY

Neither Orchid Technology nor anyone else who has
been involved in the creation, production or delivery of
this product shall be liable for any direct, indirect, special,
punitive, consequential or incidental damages (including,
without limitation, damages for loss of business profits,
business interruption, loss of business information and
the like) arising out of the use of or inability to use this
product, even if Orchid Technology has been advised of
the possibility of such damages.

Because some states do not allow the exclusion of liability
for consequential or incidental damages, the above limi-
tation may not apply to you. In any event, Orchid
Technology's liability arising in any manner in connection
with this product, whether based in contract, product
liability, or tort, shall not exceed the purchase price of the
product.
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FCC NOTICE

NuSound PnP 32
Certified compliant with FCC Class B limits, part 15

To meet FCC requirements, shielded cables are required
to connect the unit to a Class B certified device.

“This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.”

This equipment generates and uses radio frequency energy and, if not installed and
used properly in strict accordance with the manufacturer’s instructions, may cause
interference to radio or television reception.

This device has been tested and found to comply with the limits for a Class B
computing device in accordance with the specifications in Subpart J of Part 15 of FCC
Rules, which are designed to provide reasonable protection against such interference
in a residential installation. Only equipment (computer input/output devices, termi-
nals, printers, etc.) certified to comply with the Class B limits may be attached to this
product.

If this equipment causes interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try and
correct the interference by one or more of the following measures:

1. Reorient the receiving antenna.

2. Relocate the computer with respect to the receiver.

3. Move the computer away from the receiver.

4. Plug the computer into an outlet which resides on a different circuit breaker
than the receiver.

5. If necessary, consult your dealer, or an experienced radio or television
technician for additional suggestions.

You may find the booklet How To Identify and Resolve Radio-TV Interference
Problems helpful. It was prepared by the Federal Communications Commission and
is available from the U.S. Government Printing Office, Washington, DC 20402. Refer
to stock number: 004-000-00345-4.

Orchid Technology is not responsible for any radio or TV interference caused by
unauthorized modifications to this equipment. It is the responsibility of the user to
correct such interference.

Operation with non-certified equipment is likely to result in interference to radio and
TV reception. The user must use shielded interface cables in order to maintain the
product within FCC compliance.

FCC

53



NuSound PnP 32 User's Manual

Declaration of Conformity

54

DECLARATION OF CONFORMITY

Application of Council Directives 89/336/EEC and 72/23/EEC.

Standards to which the conformity is declared:

EN55022 EN50082-1 IEC801-2 IEC801-3 IEC801-4

Manufacturer's Name: Micronics Computers, Inc.

Manufacturer's Address: 221 Warren Avenue
Fremont, California 94539
USA

Tel: (510) 651-2300
Fax: (510) 651-9450

Type of Equipment: Sound card for Personal Computer

Model Name: NuSound PnP 32

Tested By: BEMA Technology Corp.
4063 Clipper Court
Fremont, California 94538
USA

Tel: (510) 490-9215
Fax: (510) 490-5790

Test Engineers: Jagtar Sahota (EN55022, EN50082-1,
IEC801-2, IEC801-3, IEC8014)

Nasir Pirani (EN55022, EN50082-1,
IEC801-2, IEC801-3, IEC8014)

I, the undersigned, hereby declare that the specified equipment
conforms to the directives and standards listed above.

Ming Ming Hsu
Director of Technical Services
November 12, 1995
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